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Chapter 1 – System Overview

Congratulations, you have just purchased an open automation solution for your
HMI requirements. The OpenHMI™ workstation is based on PC architecture
and powered by commercial HMI software. It combines widely used Windows-
based HMI software, Ethernet connectivity, and preinstalled cards for the device
network of your choice into one workstation, delivering an open and integrated
operator interface.

The open architecture of the OpenHMI workstation consists of two parts: the
configurator software and the runtime workstation. The OpenHMI™
configurator software, which can be installed on a desktop or industrial PC, is a
Microsoft® Windows®-based, 32-bit object-oriented, graphic human-machine
interface (HMI) application. It allows you to create and implement an open
Windows-based operator interface application that you can integrate with
Internet applications and off-the-shelf software.

A completed operator interface application is downloaded to an OpenHMI
workstation with the runtime software. This runtime workstation processes
scanned data from connected devices, according to parameters defined in the
application, and displays the data on the graphic operator interface.

This manual, the OpenHMI Workstation Setup and Startup Guide, will instruct
you on the use of the runtime software on your OpenHMI workstation. This
manual is for both the 3400 series (3408, 3410, and 3412) and the 3500 series
(3510, 3512, and 3515) of OpenHMI workstations. In this manual, 35xx refers to
any 3500 series workstation, 34xx refers to any 3400 series workstation, and
3xxx refers to workstations of both series. Check boxes are included with the
procedures for your convenience. Note boxes highlight additional material of
interest and Warning boxes highlight safety concerns.
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 Unpacking the System
 When you remove the system from its box, verify that you have the parts listed
below. Save the box and inner wrapping in case you need to reship the unit. All
software is already loaded on the workstation, but whenever possible copies of
the workstation software are provided on floppy disk or CD as backups.

�  Read Me First (34xx)

�  

�  

OpenHMI Runtime License (floppy disk labeled RT-500 Tag/50 WIN or
RT-1000 Tag/100 WIN)

�  

OpenHMI Software (2 CDs labeled OpenHMI, Productivity Pack and
I/O Servers)

�  

Video drivers (floppy disk)

�  

Keypad utility disk (floppy disk)

�  

Microsoft CD-ROM setup boot disk (Windows 95 only)

�  

Microsoft Windows NT or 95 operating system software and manual. The
product ID number affixed to the manual is required for system startup.

�  

3xxx Series System Guide

�  

OpenHMI Workstation Setup and Startup Guide (this manual)

�  

CPU board manual

�  

Optional keypad insert (34xx)

�

 Hardware bag with:

�  Power connector
�  Eight 8-32 hex nuts (3408)
�  Twelve 10-32 hex nuts (3410, 3412, 3510, 3512)
�  Fourteen 10-32 hex nuts (3512KPM, 3515)
�  Cable clamp with screw for power cord strain relief (34xx, 3510, 3512)
�  Angle bracket for power cord strain relief (3512KPM, 3515)
�  Four standoffs and four 4-40 screws for mounting PC/104 expansion

cards (3408, 3410)
�  Blank floppy disk and Emergency Recovery Disk (ERD) label
�  Ethernet Disk (floppy disk)
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Quick Startup
This section provides the steps to get the system running without explaining
system capabilities and options.

Note
Do not attach a PS/2 mouse to touchscreen units. The mouse port is not
available on touchscreen units. If COM 2 is not being used (by the IrDA
port or another serial device), you may connect a serial mouse to a serial
port on the unit.

Note
OpenHMI workstations do not include power cords because the unit is
generally hardwired into the panel. Refer to your workstation hardware
documentation to create a power cord if you wish to run the workstation
outside of the panel.

Warning
To avoid injury from electrical shock, disconnect the power cord before
making any adjustments to the inside or outside of the computer.

You must perform the steps outlined on the next three pages before you can
download a developed OpenHMI application to the workstation.
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For All Workstations
See your hardware documentation for additional details on equipment setup.

 Attach equipment:
• Keyboard

• Mouse (except for touchscreen models)

• External floppy drive (optional)

• Ethernet network connection (optional)

 Create a power cord, if necessary.

 Turn on power to the unit. The system should boot up in a few minutes.

 If you have a unit with an STN display (3406 and 3408 only), you may need to
adjust the display contrast. On units with keypads, press and hold the F/A key,
then press the left or right cursor keys to increase or decrease contrast. On
units without keypads use the contrast keys located below the flat panel
display. TFT displays don’t require adjustment; the unit automatically adjusts
the contrast.

Contrast Keys F/A Key

For Windows 95 Workstations

 When booting the system up for the first time, the Windows Setup Wizard
will appear before the Windows operating system starts. Enter your Name and
Company in the first dialog box.

 When the license agreement appears, click Accept to agree to the terms and
continue the load and installation. (If you select Don’t Accept, the operating
system will shut down and the installation will not be completed.)

 When prompted for your Product ID, locate your Windows operating system
manual and type in the Product ID that is on the package.

 Click Next.

 Click Finish to complete the load and installation.
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 Enter your Windows username and password. (You can omit the password at
this time and assign it later.)

 Click OK.

 New screens will appear:
• New Hardware Found

• Copying Files

• Version Conflicts (click Yes when prompted with version conflict
dialog windows)

 Date and Time properties appear. To change the time zone, click on the drop
down box and then choose the appropriate zone.

 Add the Printer Wizard:
• Ask your IS Department and follow instructions or consult your printer

manual for additional information on installing your printer.

• Click Next. If no printer is attached, click Cancel.

 The Welcome to Windows screen appears. Either take the optional tour or
click Close.

For Windows NT Workstations

 When booting up the system for the first time, the Windows Setup Wizard
appears before the Windows operating system starts. The first dialog box
displays the license agreement. Click Accept to agree to the terms and
continue the load and installation. (If you select Don’t Accept, the operating
system will shut down and the installation will not be completed.) When you
accept the agreement, the startup program initializes.

 Click Next, so that the startup program can begin.

 When prompted, enter your Name and Organization.

 When prompted for your Product ID, you must locate the Windows operating
system backup kit and type in the Product ID on the package.

 When prompted for a computer name, enter a name (check with the system
administrator) then click Next.
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 When prompted for an administrator password, enter a password (check with
the system administrator) then click Next.

Note
If you wish to configure the workstation to log on and start OpenHMI
applications automatically after restarting the system, you should enter an
administrator password. Otherwise it will be difficult to make
administrator level changes to the Windows configuration. It is
recommended that you write down your password for future reference.

 Click Next to continue the startup.

 As startup continues, new screens may appear:
• New Hardware Found

• Copying Files

• File Replacement (click No when prompted to replace new files with
old source files)

 Enter the Date and Time when prompted.

 When startup is complete, click Restart.

 To login after the system restarts, press and hold CTRL and ALT, then press
DELETE. At the prompt, enter your name and password and press ENTER. The
screen should then show your Windows NT desktop.
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Emergency Recovery Disk (ERD) Procedure
After you unpack and start up your OpenHMI workstation, it is highly
recommended that you make an ERD. You must have an ERD to restore your
system information if there are problems that prevent your system from booting
normally.

 Locate the blank 3.5″ floppy disk provided with the OpenHMI workstation.

 Start the workstation.

 Double-click the Create ERD shortcut, located on the desktop.

 When SYS_ERU prompts you, insert the disk and press any key to continue.

 Click Next to when you see the Emergency Recovery Utility welcome screen.

 Click Next to accept the default Select Drive path.

 Remove the disk from the drive and apply the label marked Emergency
Recovery Disk. You should also write the date on the label.

 Reinsert the labeled disk and click OK.

 Click Next to accept the default for Under Files to Saved.

 Click OK when the Emergency Recovery Disk Utility has finished.

 Remove the ERD disk and store it in a safe place with your system manuals.
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Chapter 2 – Loading and Starting
Applications

You should read this chapter for an overview of the application manager and the
procedures for downloading applications to a workstation. In order to investigate
all of the capabilities of OpenHMI, you should read the OpenHMI User's Guide
which is installed with your program as a PDF file.
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InTouch Application Manager
You may use the InTouch Application Manager to open and delete existing
applications in WindowViewer. If you wish to configure applications on this
unit, install the OpenHMI system configurator license and follow the directions
in the Getting Started manual. After completing application development,
reinstall the runtime version of OpenHMI so that your system can run without
the time constraints of the configurator software.

Running the InTouch Application Manager

 Start the OpenHMI program (INTOUCH.EXE). This can be done by clicking
OpenHMI in the Start menu’s Programs folder or by double-clicking an
OpenHMI desktop shortcut. The InTouch - Application Manager dialog
box appears.

 

The InTouch - Application Manager’s drop-down menus and push buttons
function just like those of any Windows application.

When you select an application in the list, its name and its description will
appear in the box at the bottom of the screen. If you right-click the
description box, a menu appears displaying the commands that you can
apply to the selected text.

You can also execute several of the InTouch - Application Manager menu
commands from the menu that appears when you click the right mouse
button as you select an application (next page).
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 To rename an application, right-click the application in the list, and then click
Rename. Type the new name and press ENTER.

 To delete an application, right-click the application in the list and then click
Delete. A message box will appear asking you to confirm the deletion. Click
Yes to delete the application. Deleting an application only deletes it from the
InTouch - Application Manager. The application is still present in its
directory. To redisplay a deleted application, follow the next step (used to
display a transferred application).

 After an application is transferred to your workstation (see page 2-9), it does
not automatically appear in the InTouch - Application Manager window.
You need to display it first. On the Tools menu, click Find Applications. The
Starting directory for search: dialog box appears:
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Locate the directory in which you want to search for applications, and then
click OK. The InTouch - Application Manager will appear, displaying
icons for all applications found in that directory.

Note
If you right-click in the window, a menu will appear displaying the
commands you can apply to a selected item.
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The InTouch - Application Manager Tools
When OpenHMI is initially run, the InTouch - Application Manager’s toolbar
and status bar are displayed by default. To hide the toolbar, select Toolbar on
the View menu. To show it again, repeat this step. To hide the status bar, select
Status Bar on the View menu. To show it again, repeat this step.

The following list briefly describes the InTouch - Application Manager
toolbar buttons which function in the runtime version of OpenHMI:

Button Description
Executes the WindowViewer command on the File
menu to open the selected application in
WindowViewer.

Executes the Large Icons command on the View menu
to display large icons for the listed applications.

Executes the Small Icons command on the View menu
to display small icons for the listed applications.

Executes the List command on the View menu to
change the dialog box to the list view mode. For
example:
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Executes the Details command on the View menu to
change the dialog box to the details view mode. For
example:

 

Double-clicking the right vertical separation bar of a column header will
auto-size the column.

If you right-click any of the column headers, or click a blank area of the
window, or click a detail (other than the application name) the following
menu appears:

 

If you point to View, the following submenu appears:

 

These commands are also found on the View menu. They control the
display list in the InTouch - Application Manager.
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Opens the Node Properties dialog box that you
will use to set Dynamic Resolution Conversion
(DRC). The use of this dialog box is covered in
your developer documentation.

This dialog box can also be opened using Node Properties in the Tools
menu.

Note
Other features and menu selections are not operational in the runtime
version of OpenHMI’s WindowViewer screen.

If you start Windowmaker, you will get a Name for this Node… dialog
box and an underlying box explaining that the license does not enable you
to open that particular function. Click Cancel on the dialog box, click OK
on the underlying box, and restart OpenHMI.

If you start DBLoad or DBDump, click No, then OK, and then restart
OpenHMI.

If you start New InTouch Application, click Cancel in the Create New
Application wizard.
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Note
When an application is selected in the Application Manager display list,
selecting the Properties command on the File menu will cause the
Properties dialog box for that application to appear:
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Downloading the Application
For a real world application, you need to download your application to a
workstation before you can start communicating with I/O. As discussed in
the introduction, a Pro-face HMI application consists of two
components: a development system (the WindowMaker configurator
software installed on any PC) and the runtime environment (the
WindowView runtime software on an OpenHMI workstation). When you
complete your application, you can download the application through
several different media.

After you have downloaded an application, you can start it and begin I/O
communications by running the WindowView program on the workstation.

Development
PC

Ethernet Runtime
Workstation

Transfer
Application Files

Direct Serial or 
Parallel Connection

Floppy Diskette

IrDA Port
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Floppy Disk

 Log onto your runtime system.

 From the Start menu’s Programs folder, click Windows Explorer.

 Select the project directory that is to be transferred (usually under c:\program
files\FactorySuite\Intouch).

 Copy the entire folder to another directory location and rename the folder. We
recommend using YourAppname_Backup as a naming convention, where
YourAppname is your application name.

 In the backup folder delete the files with the following extensions:

• .wbk

• .wvw

• .avl

 Compress the remaining files with a compression utility, such as WinZip®, and
copy to a floppy disk.

 Log onto your runtime system.

 Extract the compressed files to a file folder with the original project name.

Note
Don’t plug in the floppy drive while the disk is in the drive. Doing this
may corrupt the data on the disk.

Peer-to-Peer Direct Ethernet Connection
To download the application through a direct network connection, you will need
an install and configure in the development system an Ethernet card that
connects to the runtime workstation’s built-in Ethernet.

Configure Card and Connection
Follow these procedures to configure the Ethernet card on the development
system and configure the network communications on both systems.
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The Connecting Cable
Use only four of the eight pins. Pins 1 and 2 must be a pair, and pins 3 and 6
must be a pair. Wire the cable as follows:

Function Pin# Pin# Function

TX+ 1 <————> 3 RX+

TX- 2 <————> 6 RX-

RX+ 3 <————> 1 TX+

RX- 6 <————> 2 TX-

Windows 95 Systems

 Log onto your runtime system.

 From the Start menu’s Settings folder, click Control Panel.

 Double-click the Network icon.

 In the Network dialog box select the Configuration tab.

 Under the Configuration tab, click on the Add button

 Development PCs require a configured adapter. Follow these steps if the
Ethernet adapter is not configured on your development PC:

1. Select Adapter and click on the Add button.

2. From the list box select the driver for your type of adapter or click on
Have Disk if you have unlisted third party drivers. (You will need to
specify a directory or drive to select unlisted third party drivers from.)

3. Click OK.

4. Select Protocol and click on the Add button.

5. From the list box select Microsoft from the Manufacturers list box and
Net BEUI from the Network Protocols list box.

6. Click OK.

 Select Client and click on the Add button.

 From the list box select Microsoft from the Manufacturers list box and Client
for Microsoft Networks from the Network Clients list box.
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 Click OK.

 Under the Configuration tab, click on the Add button

 Click on the File and Print Sharing button.

 Check the I want to be able to give others access to my files item.

 Click OK.

 Select the Identification tab.

 Enter the computer name (different name for each computer) and workgroup
(enter the same workgroup name for each computer).

 Select the Access Control tab.

 Select the Share-level Access Control radio button.

 Click on the Network dialog’s OK button.

 When prompted to restart the computer, select Yes.

Windows NT Systems

 Log onto your runtime system.

 From the Start menu’s Settings folder, click Control Panel.

 Double-click the Network icon.

 In the Network dialog select the Configuration tab.

 Under the Configuration tab, click on the Add button

 Development PCs require a configured adapter. Follow these steps if the
Ethernet adapter is not configured on your development PC:

1. Select Adapter and click on the Add button.

2. From the list box select the driver for your type of adapter or click on
Have Disk if you have unlisted third party drivers. (You will need to
specify a directory or drive to select unlisted third party drivers from.)

3. Click OK.

4. Under the Configuration tab, click on the Add button



Chapter 2 – Loading and Starting Applications

2-13

5. Select Protocol and click on the Add button.

6. From the list box select Microsoft from the Manufacturers list box
and Net BEUI from the Network Protocols list box.

7. Click OK.

 Under the Configuration tab, click on the Add button

 Select the Identification tab.

 Enter the computer name (different name for each computer) and workgroup
(enter same workgroup name for each computer).

 Click on the Network dialog’s OK button.

 When prompted to restart the computer, select Yes.
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Transfer Application Files
To transfer your files you will first need to set up file sharing on your runtime
PC. You will than access the shared folder from the development system and
transfer the files to the runtime system.

File Sharing on a Windows 95 Runtime Workstation

 Log onto your runtime system.

 From the Start menu’s Programs folder, click Windows Explorer.

 Find and select the folder that you want to copy your OpenHMI application
files into.

 Select File, then select Properties.

 Select the Sharing tab, then select the Shared As radio button.

 Enter a share name.

 Set the access type to Full.

Note
After you set the sharing properties for the project folder, you can transfer
files when needed to update the workstation with application changes.

 Click OK.

File Sharing on a Windows NT Runtime Workstation

 Log onto the runtime system as an administrator.

 From the Start menu open the User Manager (Programs/Administrative Tools
(Common)/User Manager).

 Create a new user and enter the username and password of the development
system that the application files will be transferred from.

 Unless your application requirements demand otherwise, select the Password
Never Expires radio button.
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 Click OK to save the new user.

 Close the User Manager.

 Open Windows Explorer.

 Find and select the folder that you want to copy your OpenHMI application
files into.

 Select File, then select Properties.

 Select the Sharing tab, then select the Shared As radio button.

 Click on the Permissions button.

 Access to the shared directory defaults to full access for everyone. If more
security is desired, click on the Remove button to remove the access.

 To add the new (development system) user from the Sharing tab:

1. Click on the Add button, then click on the Show Users button.

2. Select the new user from the list box.

3. Set the access type to Full.

Note
After you set the given permissions for the project folder, you can transfer
files when needed to update the workstation with application changes.
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Transfer Files to Shared Runtime Workstation Folder

 To transfer the files between two Windows NT systems, two Windows 95
systems, or from a Windows NT development system to a Windows 95
runtime system:

1. Log onto the runtime workstation.

2. Open the Windows Explorer and locate the runtime workstations name
and shared folder under the Network Neighborhood icon.

3. Drag the development system’s application files into the shared runtime
folder.

 To transfer the files from a Windows 95 development system to a Windows NT
runtime system:

1. Log onto the development workstation.

2. Open the Windows Explorer and select Find Computer from the
Tools menu.

3. In the Find Computer dialog enter the name of the runtime
workstation.

4. Click Find Now.

5. Double-click on the computer icon that appears.

6. Drag the development system’s application files into the shared runtime
folder.
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Existing Ethernet Network Connection
You will need installed Ethernet cards in the development system and the
runtime workstation that are physically connected to the Ethernet network.

Configuring your Ethernet Connection
These steps work assuming that your network adapter on your runtime
workstation is functioning properly and you can go out on the network.

Windows 95 Systems

 Log onto your runtime system.

 From the Start menu’s Settings folder, click Control Panel.

 Double-click the Network icon.

 In the Network dialog box select the Configuration tab.

 Under the Configuration tab, click on the Add button

 Select Client and click on the Add button.

 From the list box select Microsoft from the Manufacturers list box and
Client for Microsoft Networks from the Network Clients list box.

 Click OK.

 Click on the File and Print Sharing button.

 Verify that both check boxes are checked to share folders.

 Click OK.

 Select the Identification tab.

 Enter the computer name (different name for each computer) and workgroup
(enter same workgroup name for development PC and runtime workstation).

 Select the Access Control tab.

 Select the Share-level Access Control radio button.

 Click on the Network dialog’s OK button.
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 When prompted to restart the computer, select Yes.

Windows NT Systems

 Log onto your runtime system.

 From the Start menu’s Settings folder, click Control Panel.

 Double-click the Network icon.

 In the Network dialog box select the Configuration tab.

 Under the Configuration tab, click on the Add button

 Select Protocol and click on the Add button.

 From the list box select Microsoft from the Manufacturers list box and Net
BEUI from the Network Protocols list box.

 Click OK.

 Select the Identification tab.

 Enter the computer name (different name for each computer) and workgroup
(enter same workgroup name for development PC and runtime workstation).

 Click on the Network dialog box’s OK button.

 When prompted to restart the computer, select Yes.
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Transfer Application Files
To transfer your files you will first need to set up file sharing on your runtime
PC. You will than access the shared folder from the development system and
transfer the files to the runtime system.

File Sharing on a Windows 95 Runtime Workstation

 Log onto your runtime system.

 From the Start menu’s Programs folder, click Windows Explorer.

 Find and select the folder that you want to copy your OpenHMI application
files into.

 Select File, then select Properties.

 Select the Sharing tab, then select the Shared As radio button.

 Enter a share name.

 Set the access type to Full.

Note
After you set the sharing properties for the project folder, you can transfer
files when needed to update the workstation with application changes.

 Click OK.

File Sharing on a Windows NT Runtime Workstation

 Log onto the runtime system as an administrator.

 From the Start menu open the User Manager (Programs/Administrative
Tools (Common)/User Manager).

 Create a new user and enter the username and password of the development
system that the application files will be transferred from.
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 Unless your application requirements demand otherwise, select the Password
Never Expires radio button.

 Click OK to save the new user.

 Close the User Manager.

 From the Start menu’s Programs folder, click Windows Explorer.

 Find and select the folder that you want to copy your OpenHMI application
files into.

 Select File, then select Properties.

 Select the Sharing tab, then select the Shared As radio button.

 Click on the Permissions button.

 Access to the shared directory defaults to full access for everyone. If more
security is desired, click on the Remove button to remove the access.

 To add the new (development system) user from the Sharing tab:

1. Click on the Add button, then click on the Show Users button.

2. Select the new user from the list box.

3. Set the access type to Full.

Note
After you set the given permissions for the project folder, you can transfer
files when needed to update the workstation with application changes.

Transfer Files to Shared Runtime Workstation Folder

 To transfer the files between two Windows NT systems, two Windows 95
systems, or from a Windows NT development system to a Windows 95
runtime system:

1. Log onto the runtime workstation.

2. Open the Windows Explorer and locate the runtime computer and then
the shared folder under the Network Neighborhood icon.
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3. Drag the development system’s application files into the shared runtime
folder.

 To transfer the files from a Windows 95 development system to a Windows NT
runtime system:

1. Log onto the development workstation.

2. Open the Windows Explorer and select Find Computer from the
Tools menu.

3. In the Find Computer dialog enter the name of the runtime
workstation.

4. Click Find Now.

5. Double-click on the computer icon that appears.

6. Drag the development system’s application files into the shared runtime
folder.

Serial Connection (For Windows 95)

 Plug serial cable from development system to runtime workstation’s COM1
RS-232 port.

 Plug keyboard into runtime workstations with touchscreen.

 Power up both PCs.

 For both PCs add the File and Print Sharing service.

1. Log onto the PC.

2. Open the Control Panel and double-click on the Network icon.

3. In the Network dialog select the Configuration tab.

4. Under the Configuration tab, click on the Add button

5. Select Services and click on the Add button.

6. From the list box select Microsoft from the Manufacturers list box and
Print and File Sharing for Microsoft Networks from the Services list
box.

7. Click OK.

Transfer Application Files
You can initiate file transfers from the development PC/host (download) or
the runtime workstation/guest (upload).
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 Log onto your runtime system.

 From the Start menu’s Programs folder, click Windows Explorer.

 Select the project directory that is to be transferred (usually under c:\program
files\ FactorySuite\Intouch).

 Select File, then select Properties.

 Select the Sharing tab, then select the Shared As radio button.

 Enter a share name.

 Set the access type:

• To Read-only if you plan to download files from the runtime
workstation.

• To Full if you plan to upload files from the development system.

Note
After you set the sharing properties for the project folder, you can transfer
files when needed to update the workstation with application changes.

 Click OK.

 Log onto the runtime workstation to set it up as the guest computer.

 From the Start menu, select Programs/Accessories/Direct Cable
Connection.

 Click on the Change button.

 Select Guest, then click on Next.

 Return to the development PC to set it up as the host computer.

 From the Start menu, select Programs/Accessories/Direct Cable
Connection.

 Click on the Change button.

 Select Host, then click on Next.
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 Select Serial Cable on COM1, then click on Next.

 Click on Finish. Leave the User password protection box unchecked.

 Return to the runtime workstation and click the OK button on the timeout
prompt.

 The workstation will prompt you for the host computer name. Refer to the
development PC to determine the computer name you should enter.
(Double-click on the Network icon in the Control Panel, then select the
Identification tab.)

 Click on the OK button.

 To transfer the files from one computer to another:

1. Log onto the development system or runtime workstation.

2. Open the Windows Explorer and locate the shared folder under the
Network Neighborhood icon.

3. Select the development system’s project folder and drag it into the
workstation’s c:\program files\FactorySuite\Intouch folder.
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IrDA Port (For Windows 95)

Configure the IrDA Port

If you choose to transfer files through the IrDA port you must first configure
the port for the development PC and runtime workstation.

Note
These steps cover IrDA port configuration for the runtime workstation. If
the development PC’s IrDA port is not already configured, you should
refer to the PC’s documentation to configure the port.

 Press the F2 key while the system boots up to enter the CMOS setup of your
OpenHMI workstation. (If you have trouble, please refer to the system
manual.)

 Use the right arrow to select the Advanced menu.

 Press ENTER to select the first item, Integrated Peripherals.

 Use the down arrow to select UART 2 Mode.

 Use the + key to change the UART2 Mode field to IrDA.

 Press the ESC key twice to exit the CMOS submenus.

 Press ENTER to save changes, then again to confirm the changes and exit.

 Allow system to boot to Windows 95.

 After Windows 95 has started, from the Start menu’s Settings folder, click
Control Panel.

 Double-click on the Add New Hardware icon.

 To complete the Add New Hardware wizard:

1. Click on Next.

2. When prompted if you want Windows to search for new hardware select
the No radio button, then click on the Next button.

3. Click on Next.



Chapter 2 – Loading and Starting Applications

2-25

4. Select Infrared from the list box of Hardware Types, then click on Next.

5. Click on Next.

6. Click on Next to accept the defaults of Standard Infrared Devices and
Built-in Infrared Port on laptop or desktop. (If needed, change
dialog fields to match these default values.)

7. From the Available Ports list box, select the port that this infrared device
is physically connected to COM2, then click on Next.

8. Click on Next to accept the default ports COM4 and LPT3. (If needed,
change dialog fields to match these default values.) After this prompt,
the wizard will begin to install and configure the necessary driver and
other files. It may prompt you to insert your Windows 95 CD, so that it
can copy files to the hard drive.

9. Select Finish.

 Double-click on the Infrared icon in the Control Panel. (If the icon does not
appear in the window, press F5 to refresh the view.)

 Select the Options tab.

 Verify that Enable infrared communication on is set to COM2 and that
Providing application support on COM4 and LPT3 appears.

 Click on the OK button to run the driver.

File and Print Sharing

Before you can transfer application files through the configured IrDA port,
you will need to add the File and Print Sharing service to the PC and
runtime workstation.

 Log onto the PC.

 From the Start menu’s Settings folder, click Control Panel.

 Double-click on the Network icon.

 In the Network dialog select the Configuration tab.

 Under the Configuration tab, click on the Add button

 Select Services and click on the Add button.
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 From the list box select Microsoft from the Manufacturers list box and Print
and File Sharing for Microsoft Networks from the Services list box.

 Click OK. You may need to restart your system.

Transfer Application Files

You can initiate file transfers from the development PC/host (download) or
the runtime workstation/guest (upload).

 Log onto your development system.

 From the Start menu’s Programs folder, click Windows Explorer.

 Select the project directory that is to be transferred (usually under c:\program
files\ FactorySuite\Intouch).

 Select File, then select Properties.

 Select the Sharing tab, then select the Shared As radio button.

 Enter a share name.

 Set the access type:

• To Read-only if you plan to download files from the runtime
workstation.

• To Full if you plan to upload files from the development system.

Note
After you set the sharing properties for the project folder, you can transfer
files when needed to update the workstation with application changes.

 Click OK.

 Log onto the runtime workstation to set it up as the guest computer.

 From the Start menu, select Programs/Accessories/Direct Cable
Connection.

 Click on the Change button.

 Select Guest, then click on Next.
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 Select Serial Cable on COM4, then click on Next.

 Click on Finish. The computer will now try to connect using the IrDA port. It
may time out and post the message Wait here until the ‘other’ computer is
ready to communicate.

 Return to the development PC to set it up as the host computer.

 From the Start menu, select Programs/Accessories/Direct Cable
Connection.

 Click on the Change button.

 Select Host, then click on Next.

 Select Serial Cable on COM4, then click on Next.

 Click on Finish. They will now try to connect using the IrDA port. Leave the
User password protection box unchecked.

 Return to the runtime workstation and click the OK button on the timeout
prompt.

Note
Both PCs should now be able to see each other if they are in range. The
IrDA icon will appear on the Windows taskbar.

 The workstation will prompt you for the host computer name. Refer to the
development PC to determine the computer name you should enter.
(Double-click on the Network icon in the Control Panel, then select the
Identification tab.)

 Click on the OK button.

 To transfer the files from one computer to another:

1. Log onto the development system or runtime workstation.

2. Open the Windows Explorer and locate the shared folder under the
Network Neighborhood icon.
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3. Select the development system’s project folder and drag it into the
workstation’s c:\program files\FactorySuite\Intouch folder.
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Automatic Application Startup
You can automate some or all of the login and application startup process on an
OpenHMI workstation.

Set Automatic Login
On a Windows 95 workstation you can bypass the login prompt that appears
after the system boots up. We recommend the Tweek UI utility, which is
preloaded on a Windows 95 OpenHMI workstation.

Note for Windows NT Workstation
Automatic login cannot be configured on a Windows NT workstation.
When the workstation is restarted, an administrator must log onto the
workstation before it will start the OpenHMI application.

 From the desktop Start menu, select Settings then Control Panel, and choose
the Start Menu Programs tab.

 Double-click the  icon.
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 Select the Network tab.

 Check the Log on automatically at system startup checkbox.

 Enter your logon User name and Password in the text boxes. If you have a
password, you must enter it.

 Click OK.

 From the desktop Start menu, select Shutdown.

 In the Shut Down Windows dialog that appears, select the Restart Windows
radio button and click OK.
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 After the system restarts, you may be prompted with a welcome screen. If it
appears, you should uncheck the Show this welcome screen next time
checkbox, so the welcome screen will not appear when the system restarts and
interfere with automatic OpenHMI application startup.
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Set Application Startup

Note
The default setting for the OpenHMI workstation is to boot into the
Windows desktop.

 From the desktop Start menu, select Settings then Control Panel, and choose
the Start Menu Programs tab.

 Click Add to view the Create Shortcut window

 Load your I/O Server using the dialog’s browse button. Locate the I/O Server
(EXE) which should be located in a separate folder C:\Servers (versions
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earlier than 7.0) and C:\Program Files\FactorySuite\IOServer (version 7.0
and above)

 Select the I/O Server Program file then select Open. Click Next.

 Click Add again to view the Create Shortcut window

 Type “C:\Program Files\FactorySuite\InTouch\view.exe” “C:\
Program Files\FactorySuite\InTouch\your application folder

name” into the command line and select Next. You must type the quotes. Also,
note that there is a space between the items in quotes. For example:
“C:\Program Files\FactorySuite\InTouch\view.exe” “C:\

Program Files\FactorySuite\InTouch\demoapp1\640\”.

 In the Select program folder window select the Startup folder then click
Next.

 The default name for the icon will be view.exe. You may select another name
for the shortcut if you would like. Select Finish when complete.

 Click OK in the Taskbar Properties window.
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Chapter 3 – OpenHMI Troubleshooting
and Reinstallation

This chapter provides a list of OpenHMI application errors that may require
reinstallation of the OpenHMI software. It also provides reinstallation
instructions. Consult your workstation hardware documentation for general
system troubleshooting information and installation, operation, and maintenance
information.

Note
When replacing a particular unit or performing service procedures,
remember that the unit may have been customized and options may have
been installed. Make sure that you maintain a record of configuration
changes that were made to support these customizations or options.
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OpenHMI Application Errors
You may need to reinstall some or all of your OpenHMI software if you have
any of the following application problems:

 OpenHMI application locks up

 File errors in WindowViewer

 Communication errors

Possible solutions for recovering from OpenHMI application errors are:

 Reload the application onto the OpenHMI workstation from your
development PC or from a backup copy of the application.

 For communications errors, reinstall the I/O Server (see page 3-6).

 If application errors are not fixed by reloading the application or I/O Server,
reinstall the OpenHMI software onto your workstation (see page 3-3).
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Reinstall OpenHMI Software

Note
If your workstation does not have a CD-ROM drive, you need a portable
CD-ROM drive (with appropriate device drivers installed) attached to the
printer port and powered on.

 Insert OpenHMI CD#1 into your CD-ROM drive.

 Click the Start button on the Taskbar, then click Run:

 

 The Run dialog box appears:

 

 Type "x:\openhmi setup" (where x is your CD-ROM drive) in the Open text
box. You must type the quotes, or the installation program will not start.

 Click OK. Factory Suite 2000 will start to load. A percentage bar will display
the installation’s progress.

 When the Welcome to the system files setup program screen appears, click
Next, then Next again at the second welcome screen.
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Note
The installation program will update existing registry entries (for TCP/IP,
user registration, DLLs, etc.). Depending on the existing entries on your
development system, these registry updates may cause the Windows
operating system to restart the workstation before the installation is
complete. If you have not selected components (last step on this page)
before you are asked to restart the operating system, you will have to
follow the installation procedure again, from the beginning.

 When the license information screen appears, click Yes if you agree with the
terms of the license. You must select Yes to complete the setup.

 Enter your name and company to complete the user information screen and
click Next.

 Click OK to verify the name and company.

 When prompted to specify a directory for common components, click Next to
accept the default. The installation program will display a progress bar as it
loads some common program components.

 If you get a Version Conflict message, click Yes to keep the existing file.

 When prompted to specify an InTouch Destination directory, click Next to
keep the default.

 If you don’t already have the Acrobat Reader installed on your system, it will
be installed onto your system. This reader allows you to view the online
documentation that the install program saves to your hard disk in PDF format.
Click Next at each step of this sequence, then OK when the sequence is
complete.

 Select components when prompted. Pro-face recommends:
InTouch
Demos that match your OpenHMI workstation’s resolution (640 x 480,
800 x 600, or 1024 x 768)
InTouch 7.0 Recipe Manager
Online Manuals
When you finish selecting components, Click Next.
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Note
The SPC and SQL components are not supported by OpenHMI runtime
workstations.

 When the configuration options screen appears, verify that Development
System and Help Files are checked and that Factory Focus and Runtime are
not checked, then click Next. The installation program will copy the remaining
files to the hard drive.

 A screen will display the components that you have selected to install. Click
Next to continue. The installation program will display a progress bar as it
completes installation.

 When installation is complete, you may select OK to review the release notes.

 Before you can start the software, you must click OK when prompted to restart
the computer, so that the required settings may take effect.
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Reinstall I/O Server

Version 7.0 Servers
Follow these steps to install a version 7.0 I/O server.

 Insert OpenHMI CD#2 into your CD-ROM drive.

 Click the Start button on the Taskbar, then click Run:

 

 The Run dialog box appears:

 

 Type "x:\io server setup" (where x is your CD-ROM drive) in the Open text
box. You must type the quotes, or the installation program will not start.

 Click OK. Factory Suite 2000 will start to load. A percentage bar will display
the installation progress.

 When prompted with a list of I/O servers, select a server and click Next.



Chapter 3 – OpenHMI Troubleshooting and Reinstallation

3-7

Note
The version of the server is indicated on the server list. If you select a
server that is below version 7.0, the rest of the installation process will
differ slightly from the version 7.0 driver installation. Refer to the next
section to install an older driver.

 When prompted to verify setup information, click Next.

 When prompted to review the I/O server release notes, in the next installation
dialog box, you may select Yes or No.

 Click Yes to continue the installation.

 When the Welcome to the system files setup program screen appears, click
Next, then Next again at the second welcome screen.

 When the license information screen appears, click Yes if you agree with the
terms of the license. You must select Yes to complete the setup.

 Verify the name and company in the user information screen and click
Next.

 Click Yes to confirm registration.

 When prompted to specify an InTouch Destination directory, click Next to
keep the default. The I/O Server setup program will install the common
components.

 If you don’t already have the Acrobat Reader installed on your system, it will
be installed onto your system. This reader allows you to view the online
documentation that the install program saves to your hard disk in PDF format.
Click Next at each step of this sequence, then OK when the sequence is
complete.

 When prompted again to specify an Intouch Destination directory, click Next to
keep the default.

 You will be prompted to select the components to install. Click Next to accept
the default of all components.

 Click Next to verify setup information and complete I/O Server installation.
The I/O Server setup program will install files for your specific server.
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 At the final prompt select Yes (then Finish) if you do not need to add more
servers and No if you need to install more servers. The system will restart. If
you selected No, the installation program will close. After you have installed
all required servers, you must restart the system so that the required settings
may take effect.

Installing Older I/O Servers (Versions below 7.0)

Note
These steps show how to complete I/O server installation if you selected
an older driver in the previous procedure.

 When prompted to verify setup information, click Next.

 When prompted to review the I/O server release notes, in the next installation
dialog, you may select Yes or No.

 Click Yes to continue the installation.

 When the Welcome to the system files setup program screen appears, click
Next.

 When the license information screen appears, click Yes, if you agree with the
terms of the license. You must select Yes to complete the setup.

 When prompted to specify an InTouch Destination directory, click Next to
keep the default.

 You will be prompted to select the components to install. Click Next to accept
the default of all components.

 Click Next to verify setup information and complete I/O Server installation.

 When prompted to add icons to the Windows Start menu, click Yes.

 When installation is complete, click OK to exit the setup program.

Note
Depending on your system and other drivers that you have installed, you
may have to restart the operating system.
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